Protocol P-13-39

Analysis of Diatoms on Microscope Slides Prepared From
USGS NAWQA Program Algae Samples

Todd Clason, Frank Acker, Eduardo Morales, and Lont Marr

1. PURPOSE

1.1. The U.S. Geological Survey’s (USGS) National Water-Quality Assessment Program (NAWQA) collects four kinds of algae samples analyzed by the Phycology Section of the Patrick Center for Environmental Research, ANSP. These include Richest Targeted Habitat (RTH), Depositional Targeted Habitat (DTH), Qualitative Multihabitat (QMH), and phytoplankton samples (Porter et al., 1993; Moulton et al., 2002). This protocol describes procedures for analyzing diatoms on microscope slides made from all four types of NAWQA algae samples.

1.2. The purpose of RTH and DTH sample analysis is to estimate the proportion of diatom taxa found in a count of 600 valves (one-half of an individual diatom cell). Results are later combined with those from analysis of the soft-algae component of the same sample (Protocol P-13-63) to provide data on algal densities (as cells per cm$^2$ of sampling surface) and amount of algal biovolume (µm$^3$ per cm$^2$ of sampling surface) at a sampling site.

1.3. The purpose of QMH sample analysis is to identify as many taxa present in the sample as possible, to provide an accurate and uniform estimate of algal taxa richness in a stream reach. An underlying assumption is that although all algal taxa present in a sample (or on a slide prepared from a sample) will not be identified, most species will be found during a reasonable search. If that effort is consistent among taxonomists, results from analyses of samples and slides will be comparable among analysts and contract laboratories” (Porter 1994). Unlike an RTH and DTH count, the number of diatoms to be counted is not fixed. Instead, the analyst scans the slide until the rate at which new species are encountered, per 100 specimens observed, drops below a defined number, or a time limit is reached.

1.4. The purpose of phytoplankton sample analysis is similar to that of RTH and DTH samples, except that the quantitative results are expressed in number of cells per volume of water. Phytoplankton samples are collected from the water column, using various sampling techniques and collection devices.

2. SCOPE

2.1. This protocol covers the identification and enumeration of diatom taxa mounted on microscope slides. Two alternative procedures are described for recording data: 1) use of the “Tabulator” program (Cotter 2002), and 2) writing on bench sheets followed by data entry directly into database tables or through use of the “DtmCnt” program. As of summer 2001, all NAWQA diatom analysts use the “Tabulator” program. For this reason, the primary methods described here pertain to analyses made using “Tabulator.” The only section relating to the “bench sheet” approach lists the data fields that must be entered into the database for each analysis. Most of the instructions for using “Tabulator” are in the...
User’s Guide (Cotter 2002). Some of those instructions are summarized here to provide an overview of the program and to help clarify how it is used in the process of analyzing NAWQA samples. Procedures not included in the “Tabulator” manual are described here.

2.2. This procedure is applicable to the analysis of diatoms in algae samples collected by the RTH, DTH, QMH, and phytoplankton sampling protocols of the USGS NAWQA program.

2.3. Personnel responsible for these procedures include diatom analysts and data entry personnel.

2.4. In March 2002, the previous version of this Protocol (RTH and DTH samples only) was merged with Protocol P-13-61, which described procedures for analysis of NAWQA QMH samples.

3. REFERENCES


4. APPARATUS/EQUIPMENT

4.1. Compound microscope:

4.1.1. Oil immersion objective (100x) with a numerical aperture of at least 1.3;

4.1.2. Eyepieces of 10-15x;

4.1.3. DIC (differential interference contrast) or bright field condenser;
4.1.4. Diamond scribe mounted on microscope’s objective stage;  
4.1.5. High intensity light source.  

4.2. Desktop computer (located at microscope if “Tabulator” program is used):  

4.2.1. Pentium II or higher processor;  
4.2.2. Software: “Tabulator” or “DtmCnt” programs by Patrick Cotter (MS Visual Basic);  
4.2.3. Network connection to ANSP Phycology Section databases (ANSP staff only).  

5. METHODS  

5.1. Diatom counts.  

5.1.1. Review the “Diatom Slide Preparation Form” and the “Diatom Slide Analysis Form” (Figure 1) contained in the “Diatom Analysis” folder and transmitted with the diatom slides from the Diatom Preparation Lab. The “Diatom Slide Analysis Form” lists sample information for each slide it accompanies, and provides space next to each listed slide to initial and date when a count is finished. It also serves as a chain-of-custody record; it must be signed by the person delivering the slides and the person receiving them. Make sure that the slides correspond with the entries on the form. Note and resolve any discrepancies.  

5.1.2. Scan slides at low to medium magnification (100x to 450x) to confirm that diatoms are evenly distributed on the coverslip, and are at a density appropriate for efficient counting. At high magnification (1000x), there should be between 5-10 diatoms per field. If there are problems with dispersion or density that would compromise the quality and accuracy of the analysis, discuss these with Diatom Preparation Lab personnel and have new slides made. Avoid counting diatoms in any disrupted areas of the mount, particularly edges that have optical aberrations. If diatoms on the slides are very sparse, refer to procedures in Protocol No. P-13-49 for handling low-density samples. Always save any count data generated for a sample, even if the number of valves or frustules is low (e.g., <100).  

5.1.3. Because slides may need to be recounted for QA/QC purposes, it is very important to clearly demarcate the areas of a slide scanned during a count. After the preliminary slide examination, secure the slide in the mechanical stage and use the microscope’s diamond scribe to etch a horizontal or vertical line (depending on personal preference) on the coverslip to mark the edge of the first row to be counted. Rows are narrow rectangular areas (strips) of the slide adjacent to the scribed line, with width equal to the field of view. Start rows far enough from the coverslip edge to avoid optical distortion, and end them near the opposite coverslip edge where diatoms are no longer clearly visible (see diagram below). Locate a starting point near one end of the etched line and make a circle with the scribe. This denotes the starting point of the count. During the count, etch a circle around the last field counted in the first row and at the beginning and end of all other rows. Always check to make sure that etching is clearly visible so that circles and lines can be located easily by others.
5.1.4. When the line and first field are etched on the coverslip, and the first field is focused under oil immersion, begin using the “Tabulator” program, following the instructions in the manual; some steps are summarized below. After opening the program, the first screen encountered is the Count Information page. Click the “New” button along the bottom edge of the page. Most fields will automatically fill with default information if this is not the first slide in the subproject to be counted; otherwise data must be added. Enter data in the fields in the “Slide” box at the top of the form. Click the “Verify Slide” button to reconfirm that the slide information is in the database. Fill in the other fields in the form, including “Frustules or Valves” and “Count Type.” For RTH and DTH samples, choose “Valves” and then “600 valves (300 cells).” For QMH samples, choose “Frustules” and then “NAWQA Qualitative (diatoms).” (Note that the selection in the “Frustules or Valves” box determines the choices available in the “Count Type” box). Click the “Save” button.

5.1.5. After the preliminary information is recorded, click the “Count Now” button. Several small text boxes are displayed to confirm data entry, and then the main “Tabulator” page appears. Before counting can proceed, select a taxa list from the bottom right “Choose List” box. The “Tabulator” manual describes how to create new lists and add new taxa to existing lists.

5.1.6. Before beginning the count, click the “Note” box in the central portion of the “Tabulator” window and record the start circle coordinates (numbers on the microscope stage). Coordinates of the first (and last) field of each row should be recorded immediately after they are scribed using the following format: “Row 1 x35.2, y87; y95; Row 2” etc. The x coordinate should only be recorded once for each row.

5.1.7. As the count commences, enter taxa observed using the discrete three-digit codes established during the taxa list building process. Enter codes with the numeric keypad on the computer keyboard. Record multiple examples of a single taxon either with code: “322 +10 enter,” for example; or by repeated hits of the enter key “322 enter, enter, etc.” Taxa may also be subtracted by typing the taxon code, followed by a minus sign and the number to be subtracted: “322 –1 enter,” for example. The program will signal an alert when the count total, as established by the count type, is reached (quantitative counts only).

On average, analysis of a slide should take approximately two hours; in no case should it exceed four hours. This does not include time spent learning new taxa when analyzing the first few samples in a new study unit.

5.1.7.1. RTH and DTH analysis. Count 600 valves. Count all partial valves that are more than 50% of the valve or that contain unique features such as recognizable central areas or distinct ends. Count all valves and fragments that extend at least halfway into the field of view.

5.1.7.2. QMH analysis. The stopping rule for QMH samples is: “Taxa found on semi-permanent slides are examined and identified in intervals (groups) of 100 frustules or valves. When examining the first interval of 100 individuals,
determine if any taxon constitutes 40 percent or more of the total. Such predominant taxa should not be tallied in subsequent intervals. Examine a minimum of 10 intervals (1000 individuals). Continue scanning intervals until two consecutive intervals have been completed in which two or fewer new taxa are encountered. It is unnecessary to scan more than 50 intervals (5000 individuals) per sample. Record the number of intervals scanned on the laboratory data sheet” (Porter 1994).

Use the following procedure for counting QMH samples with the “Tabulator” program. Count the first interval as if it were a regular RTH or DTH sample. That is, record in “Tabulator” the occurrence of each frustule viewed under the microscope. Once the first 100 hundred frustules have been counted, generate an on-screen report for the count by going to the File menu on the “Tabulator” screen and selecting Print Count. From this report, determine if any taxa in the first interval equaled or exceeded a relative abundance of 40%. Exclude these taxa from the remainder of the analysis. Close the on-screen report. Starting with the second interval, keep track of the number of frustules by using a hand counter. Record occurrence of a new species (species not encountered in the first interval) in “Tabulator” only once, the first time it is encountered. Each time an interval is finished, type “r” and then hit enter on the keyboard to proceed with the next interval. A message will appear: “Are you sure you want to end this interval?”. Hit yes. “End Row ?” (where “?” is the number of the row just completed), will then appear in the “Count Entries” window. If the 9th and 10th intervals contain two or fewer new taxa, then stop the analysis at the end of the 10th interval. Otherwise, continue the analysis until 2 consecutive intervals are found for which no more than 2 new species are recorded, up to a maximum of 50 intervals (5000 frustules).

5.1.8. When the count is finished, return to the Count Information page to complete the boxes “Date Count Finished,” “Scan Length,” and “Hours To Complete.” Then return to the “Tabulator” window and print a “Count Report” and check it carefully for errors. Make adjustments, if necessary, print a final copy, sign it, and put it in the “Diatom Analysis” folder. In “Tabulator,” select “Save Count” from the “File” menu in the top left of the “Tabulator” window. This saves the count to the underlying database. If the count data are not saved before exiting “Tabulator,” the information will be retained by the program but not added to a database. To save the data if this occurs, reopen the “Tabulator” program, enter the required information about the sample, click “Count Now” to get to the “Tabulator” window, and select “Save Count” from the “File Menu.”

Put initials and date on the “Diatom Slide Analysis” form next to the entry for the slide just counted. Return it and any other related forms to the “Diatom Analysis” folder. Clean slides of immersion oil with alcohol. When finished analyzing all slides in a subproject, give the slides and “Diatom Analysis” folder to the Phycology Section Project Manager.
5.2. **Biovolume measurements.**

5.2.1. NAWQA sample analysis requires biovolume measurements for each taxon occurring in abundance of 5% or more in any one sample in a study unit. Criteria for determining how many measurements to make of each taxon for each NAWQA study unit changed slightly from the beginning of algal analyses (1995). The basic rule, as originally specified by NAWQA, was to make 15 sets of measurements. As the number of measurements for taxa accumulated, however, the criterion was changed. Since 1999, only 5 additional sets of measurements are required for taxa in new study units if the range of those 5 sets falls within the range of all previous measurements from other study units. If the ranges do not overlap, make a full 15 measurements for the taxon. Biovolume measurements can be made during the routine process of counting slides or after all slides for a Subproject have been counted. It is likely that criteria for selecting specimens to measure will evolve as the number of measurements for common taxa accumulates.

5.2.2. Use the form “frmBiovolumeVerification” in the PHYCLGY database to determine which taxa occur in abundance of 5% or more in samples in a subproject, and therefore must be measured. The form also shows the number of measurements that are already entered in the database, and minimum, maximum and average biovolumes. Print the results. To find which slides contain the most specimens of the taxa to be measured, use the query “qryFind=>5% taxa.” Print the results. Both of the above printouts should be included in the Diatom Analysis folder.

5.2.3. Use the Biovolume Calculation feature of “Tabulator” as a convenient means for calculating and entering biovolume data directly into the NADED database (ANSP staff) or the “Tabulator” back-end database (subcontractors). The BioVol program can also be used. It is essentially a stand-alone version of the “Biovolume Calculation” feature in “Tabulator.” It is located in G:\Phycdata\VBAppInstalls\BioVol.

Choose the first microscope slide with taxa to be measured, open the “Tabulator” program, and enter the “Slide ID.” Select the “Find Counts” and “Count Now” buttons, and make the choices necessary to get to the “Tabulator” screen. Select “Biovolume Calculation” from the Documentation menu at the top of the “Tabulator” screen. The fields labeled Sample ID, Subsample ID, Slide Replicate ID, Microscope, Lens, and Conversion Factor are automatically filled with information for the slide you entered. Drop-down boxes can be used to modify any of this information if needed. The Microscope ID, Lens ID and Conversion Factor fields are linked. As soon as a given Microscope and Lens are selected from the drop-down box, a conversion factor for that microscope is shown in the Conversion Factor field. Since conversion factors are already stored in a database table accessible to the “Tabulator” program, and they are used in the calculation of biovolumes, it is extremely important NOT to make any conversion in the measurements before entering them in the required field of the Biovolume Calculations form. Simply enter readings from your ocular scale directly and as they are!

Enter the NADED Taxon ID for the specimen being measured. The taxon name field will fill-in automatically. Then select the correct shape for the taxon. If it is already filled-in, make sure it is correct. Consult the Biovolume Measurements table in NADED as a reference source for assigning shapes. The table contains shape codes...
that have been assigned to taxa in the past. The shape specifies a specific formula to
be used to calculate biovolume. The measurement fields that must be filled-in for that
shape will appear on the form. Be sure to enter data for all required dimensions.

The number of measurements made for a taxon are shown in the field labeled “# of
Measurements this session.” If measurements must be corrected, click the
“Datasheet” button at the bottom of the form and make changes in the appropriate
record. After all measurements for a taxon have been entered, press the “New taxon”
button at the bottom left of the form to begin the process with a different taxon. When
ready to go to a new slide to make measurements, enter new data in the “Slide” box
and follow same steps described above.

The Biovolume Summary window is a useful feature for keeping track of
measurements and to check that all have been made for a study unit. It is also useful
for comparing measurements for a taxon with all others made for that taxon. It is
accessed through the “Edit” menu on the top left of the Biovolume Calculation
window. Select a subproject in the central menu, click the “Diatom” button to the
right, and all taxa requiring biovolume measurements are displayed. Single taxa can be
selected and double clicked to display biovolume measurements for that taxon over all
subprojects. This is helpful for determining whether averages of current
measurements fit in the ranges determined for that taxon in other study units. Again,
reviewing data at this level can prevent significant errors.

5.3. Specimen documentation.

5.3.1. Requirements for documenting diatom species vary with subproject. In general, circle
new, unknown, unusual and outstanding diatom specimens with a diamond scribe and
image them photographically or with a digital device. This allows comparison with
reference specimens and facilitates examination by specialists. Use the following two
features, accessible from the Tabulate screen, to assist with documentation.

5.3.2. Circle specimens. Click the “Circle” button in the “Tabulation” box in the
“Tabulator” window to activate the New Circle on Slide window. Values that appear
in the fields for Taxon name, Microscope, Date, and Circler default from the
“Tabulator” screen. Enter the Circle Number, Horizontal and Vertical Coordinates
(from microscope stage), and both Cover Slip Sector (1-16) and Circle Sector (1-9)
(see illustrations). These all help document the circle and specimen location. Record
extra information concerning the documentation in the “Note” box, if necessary. You
can click the “Datasheet” button to review records for existing circles.
5.3.3. Image specimens. Click the “Image” button in the “Tabulation” box in the “Tabulator” window to activate the “Images” window. All data in fields in this window automatically default to those in the “Tabulator” window, including the name of the last taxon counted. If the taxon is not the one you want to document, choose a different name from the drop down box of the same field.

Fill in values in fields under the four tabs.

“Subject” – Taxon name and dimension measurements.

Add information in the “Length,” “Width/Diameter,” and “Striae Density” fields, making sure that the measurements are expressed in microns. If your ocular scale is not 1:1 you must make the necessary conversions. The boxes “Quality” and “Public?” can be left untouched since this is information that will be added by Academy personnel reviewing the image before it is made available on the Phycology Section's web site. We are currently not using the “Caption” field and it can be left blank. Add notes referring to any characteristic of the taxon being imaged, or any taxonomic problems that you may have had with it during sample analysis, to the “Notes” field.

“Who, where, when” – Person taking image, location, image device, etc.

Enter the location from which you are working and the “Image Device” you are using for capturing the image. In the “People” box fill the fields labeled “Determiner,” “Imager” and “Adder” with the proper information. Most of these fields, except for “Image Device” will be automatically filled in with the same data that were entered in the fields in the “Count Information” screen.

“ANSP Sample” – Sample identification information

Fields are filled in automatically.

Digital images must be taken following the steps and recommendations given in the Taxonomic Guidelines document.

When all information in the “Images” screen is complete, including in the tabbed boxes, press the “Save Record” button located on the top right portion. This will save all data in the NADED database. It will also assign the next available identification number, which will appear in the Image ID field, in the upper left hand corner. Record this number for future reference. At the time the image data are saved, the identification number (e.g., IM000027) that is assigned is automatically recorded in the “DigitalImage” table of the ALGAEIMAGE database in a field called “ImageID.” A second field called “ImageFileName” is filled-in at the same time. It contains the identification number with the extension “.png” added (e.g., IM000027.png), which corresponds to the file format used by ANSP to store image files.

Open the imaging program you are using (e.g., Photoshop v 5.5) and edit the image as desired. Save the image in the “Originals” folder located in G:\Phycdata\DATABASE\Images\images. Name the file the “Image FileName” recorded previously.
5.4. **Bench sheets.** Enter data recorded on bench sheets directly into the following fields in the specified ANSP PHYCLGY database tables or by using the “DtmCnt” program. As a quality control measure, data should be entered by someone other than the analyst. The analyst should then review the entered data to verify that they were entered correctly. The “DtmCnt” program is in G:\Phycdata\VBAppInstalls\DtmCnt.

5.4.1. Table “Diatom Count Information” has several fields that must be entered (mandatory), some that should be entered if data are available (optional), some that will be added later (verification) and several that should be skipped (not applicable):

5.4.2. Sample identifiers are mandatory: **Sample ID**, **SubSample Replicate ID**, **Slide Replicate**, and **Count Replicate ID**.

5.4.3. **Count Type** is mandatory and is “17” for RTH, DTH and phytoplankton samples, and “33” for QMH samples.

5.4.4. **Taxonomy ID** is mandatory and can be looked up in the “Taxonomy Number” table.

5.4.5. **Frustules? (Or Valves)** is mandatory. It is “No” for RTH, DTH, and phytoplankton samples and “Yes” for QMH samples.

5.4.6. **Worker ID** is mandatory, is the ID of the diatom analyst and can be looked up in the “Worker Name” table.

5.4.7. **Worker Address ID** is mandatory and can be looked up in the “Worker Address” table.

5.4.8. **Date Count Started** is optional.

5.4.9. **Date Count Finished** is mandatory.

5.4.10. **Date Count Verified** is for verification.

5.4.11. **Total Time** is mandatory, and refers to the time necessary for the count.

5.4.12. **Verifier Worker ID** is for verification and refers to the Worker ID of the person who verifies that the entered count data represents the actual data from the count.

5.4.13. **Source Data Form** is mandatory and can be looked up in the “Source Data Form” table.

5.4.14. **Diatom Analysis Form ID** is optional and refers to the code for form used to track the diatom analysis procedure.

5.4.15. **Diatom Count Footnote** is not applicable.

5.4.16. **Number Counted** is mandatory for RTH, DTH, and PP samples and should be near “600.” For QMH samples it is optional, and refers to the number of frustules scanned during the procedure.

5.4.17. **Corresponding H₂O Sample** is not applicable.

5.4.18. **Validated** is for verification.

5.4.19. **Taxa Notes** is mandatory.

5.4.20. **Microscope ID** is mandatory and can be looked up in the “Microscopes” table.

5.4.21. **Lense ID** is mandatory and can be looked up in the “Microscope Lenses” table.
5.4.22. **Magnification Changer** is mandatory and refers to the amount of magnification from auxiliary lenses (enter 1 if a magnification changer was not used).

5.4.23. **Scan Length** is mandatory and refers to the total length of the scan (in mm) during the analysis.

5.5. For each diatom species encountered, create a record in the “Diatom Count” table for RTH, DTH and phytoplankton samples, and in the “Diatom Count Qualitative” table for QMH samples. Add data to the following fields:

5.5.1. Sample Identifiers as in section 5.4.2: **Sample ID, Subsample ID, Slide Replicate ID and Count Replicate ID**.

5.5.2. **TaxonID** is the NADED number for the observed taxon.

5.5.3. **NumberCounted** is the number of valves enumerated for RTH and DTH samples; for QMH samples it is the number of frustules observed in the 1st 100-frustule interval.

5.5.4. **NumberCells** is the same as NumberCounted for diatom analyses. This field is not used for QMH samples; leave blank.

5.5.5. **TaxaNote** is “Yes” or “No” depending whether there was a taxa note concerning this taxon.

6. **QUALITY ASSURANCE/QUALITY CONTROL**

6.1. Sample and slide quality can affect the outcome of these procedures. Minor deviations that do not affect the area scanned or number of specimens observed should be described on bench sheets or in the Note portion (click the “Note” button) of the “Tabulator” program. Other deviations should be discussed with the Phycology Section Project Manager for inclusion in the project QA/QC notes.

6.2. This protocol will be carried out under the general provisions of section 5.4. of ANSP, PCER (2000): “Algal Research and Ecological Synthesis for the USGS National Water Quality Assessment (NAWQA) Program. Draft Quality Assurance Project Plan.”

According to this plan, “A total of 10% of the samples collected from each study unit will be analyzed for quality control. There will be two types of QA/QC analyses: a re-count of a diatom slide (taxa harmonization count or THC) and a complete re-processing and re-count of the chosen QA/QC sample (replicate subsample count or RSC). The THCs will be performed on diatom samples only while the RSCs will be performed on both diatom and non-diatom samples.”
### Diatom Slide Analysis Form - NAWQA

For use with Protocol P-13-39 and samples collected for the U.S.G.S. National Water Quality Assessment Program

**Phylogeny Section - Patrick Center for Environmental Research - The Academy of Natural Sciences**

**Project Name:** USGS NAWQA Algae CORE-Year 3  
**Type of Sample/Count:** RTH / DTH (600 valves/200 Cells), QMH or Phyttoplankton  
**Project ID:** GS72829  
**Subproject ID:** ANSP030101FR  
**Study Unit:** Abbeville-Pontchartrain (ACAD 2011) USGS NAWQA  
**ANSP Account Number:** 708-2302

<table>
<thead>
<tr>
<th>Sample ID</th>
<th>Client Sample ID</th>
<th>Sample Type</th>
<th>Slide Type</th>
<th>ul dipped</th>
<th>Date Completed</th>
<th>Initials</th>
<th>Site Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>GSNP116E</td>
<td>AGAD0301ARE0007E</td>
<td>RTH</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>Bayou Lecassne nr Lake Arthur, LA</td>
</tr>
<tr>
<td>GSNP120D</td>
<td>AGAD0301AQD0007E</td>
<td>QMH-milor</td>
<td>a b h l</td>
<td>150</td>
<td></td>
<td></td>
<td>Bayou Lecassne nr Lake Arthur, LA</td>
</tr>
<tr>
<td>GSNP126B</td>
<td>AGAD0301AREN0021B</td>
<td>DTH</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>MERMENTAUL RIVER @ MERMENTAUL, LA</td>
</tr>
<tr>
<td>GSNP126B</td>
<td>AGAD0301ARE0022F</td>
<td>DTH</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>MERMENTAUL RIVER @ MERMENTAUL, LA</td>
</tr>
<tr>
<td>GSNP126B</td>
<td>AGAD0301ARE0022F</td>
<td>RTH</td>
<td>a b h l</td>
<td>26</td>
<td></td>
<td></td>
<td>MERMENTAUL RIVER @ MERMENTAUL, LA</td>
</tr>
<tr>
<td>GSNP1211</td>
<td>AGAD0301ARE0021B</td>
<td>RTH</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>MERMENTAUL RIVER @ MERMENTAUL, LA</td>
</tr>
<tr>
<td>GSNP1213</td>
<td>AGAD0301ARE0022F</td>
<td>RTH</td>
<td>a b h l</td>
<td>25</td>
<td></td>
<td></td>
<td>MERMENTAUL RIVER @ MERMENTAUL, LA</td>
</tr>
<tr>
<td>GSNP1215</td>
<td>AGAD0301AQD0002B</td>
<td>QMH-milor</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>MERMENTAUL RIVER @ MERMENTAUL, LA</td>
</tr>
<tr>
<td>GSNP1217</td>
<td>AGAD0401AQD0023E</td>
<td>DTH</td>
<td>a b h l</td>
<td>40</td>
<td></td>
<td></td>
<td>BAYOU DES CANNES NR EUNICE, LA</td>
</tr>
<tr>
<td>GSNP1219</td>
<td>AGAD0401AQD0023B</td>
<td>RTH</td>
<td>a b h l</td>
<td>40</td>
<td></td>
<td></td>
<td>BAYOU DES CANNES NR EUNICE, LA</td>
</tr>
<tr>
<td>GSNP1221</td>
<td>AGAD0401AQD0023B</td>
<td>QMH-milor</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>BAYOU DES CANNES NR EUNICE, LA</td>
</tr>
<tr>
<td>GSNP1223</td>
<td>AGAD0401AQD0023B</td>
<td>DTH</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>WHISKEY CHITTO CK NR OBERLIN, LA</td>
</tr>
<tr>
<td>GSNP1225</td>
<td>AGAD0401AQD0025E</td>
<td>RTH</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>WHISKEY CHITTO CK NR OBERLIN, LA</td>
</tr>
<tr>
<td>GSNP1227</td>
<td>AGAD0401AQD0025E</td>
<td>QMH-milor</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>WHISKEY CHITTO CK NR OBERLIN, LA</td>
</tr>
<tr>
<td>GSNP1229</td>
<td>AGAD0401AQD0027E</td>
<td>DTH</td>
<td>a b h l</td>
<td>50</td>
<td></td>
<td></td>
<td>DAWSON CREEK AT BLUEBONNET BOULEVARD</td>
</tr>
<tr>
<td>GSNP1231</td>
<td>AGAD0401AQD0027E</td>
<td>RTH</td>
<td>a b h l</td>
<td>100</td>
<td></td>
<td></td>
<td>DAWSON CREEK AT BLUEBONNET BOULEVARD</td>
</tr>
<tr>
<td>GSNP1233</td>
<td>AGAD0401AQD0027E</td>
<td>QMH-milor</td>
<td>a b h l</td>
<td>50</td>
<td></td>
<td></td>
<td>DAWSON CREEK AT BLUEBONNET BOULEVARD</td>
</tr>
</tbody>
</table>

**PREPARED SLIDES TRANSMITTED BY:** ________________________  
**DATA AND SLIDES TRANSMITTED BY:** ________________________

**PREPARED SLIDES RECEIVED BY:** ________________________  
**DATA AND SLIDES RECEIVED BY:** ________________________

March 29, 2002

---

**Figure 1.** Diatom Slide Analysis form - NAWQA.